
Relay Control Panel

User Manual
Version 2.7 Rev 0





Preface

Information in this document is subject to change without notice.

© 2015 ERLPhase Power Technologies Ltd. All rights reserved.

Reproduction in any manner whatsoever without the written permission of 
ERLPhase Power Technologies Ltd. is strictly forbidden.

This manual is part of a complete set of product documentation that includes 
detailed drawings and operation. Users should evaluate the information in the 
context of the complete set of product documentation and their particular 
applications. ERLPhase assumes no liability for any incidental, indirect or 
consequential damages arising from the use of this documentation.

While all information presented is believed to be reliable and in accordance 
with accepted engineering practices, ERLPhase makes no warranties as to the 
completeness of the information.

All trademarks used in association with B-PRO, B-PRO Multi Busbar, Multi 
Busbar Protection, F-PRO, iTMU, L-PRO, ProLogic, S-PRO, T-PRO, 
TESLA, I/O Expansion Module, TESLA Control Panel, Relay Control Panel, 
RecordGraph and RecordBase are trademarks of ERLPhase Power 
Technologies Ltd.

Windows® is a registered trademark of the Microsoft Corporation.

HyperTerminal® is a registered trademark of Hilgraeve.

Modbus® is a registered trademark of Modicon.

Contact Information

ERLPhase Power Technologies Ltd.

74 Scurfield Blvd.

Winnipeg, Manitoba, Canada

R3Y 1G4

Website: www.erlphase.com

Email: info@erlphase.com

Technical Support

Email: support@erlphase.com

Tel: 1-204-477-0591
ERLPhase Power Technologies Ltd. Relay Control Panel User Manual i





Using This Guide

This user manual describes the installation and operation of the ERL Relay 
Control Panel (RCP) user interface software.

The manual uses a number of conventions to denote special information:

Example Describes

Start>Settings>Control Panel Choose the Control Panel submenu in the Set-
tings submenu on the Start menu.

Right-click Click the right mouse button.

Recordings Menu items and tabs are shown in italics.

service User input or keystrokes are shown in bold.

Text boxes similar to this one Relates important notes and information.

.. Indicates more screens.

Indicates further drop-down menu, click to dis-
play list.

Indicates a warning.
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Version Compatibility

Relay Control Panel Compatibility

Relay Version

Compatible with L-PRO 4000 Offliner v2.0 - v2.6

Compatible with L-PRO 4000 Firmware v2.0  - v2.5

Compatible with S-PRO 4000 Offliner v1.0  - v2.1

Compatible with S-PRO 4000 Firmware v1.0

Compatible with S-PRO 4001 Firmware v1.0 - v2.0

Compatible with B-PRO 4000 Offliner v2.0 - v2.2

Compatible with B-PRO 4000 Firmware v2.0

Compatible with T-PRO 4000 Offliner v1.0 - v1.3

Compatible with T-PRO 4000 Firmware v1.0 - v1.2

Compatible with F-PRO 4000 Offliner v1.0

Compatible with F-PRO 4000 Firmware v1.0

Compatible with F-PRO 2000 Offliner v1.0

Compatible with F-PRO 213 Firmware v1.0

Compatible with F-PRO 235 Firmware v1.0

Please contact ERLPhase Customer Service for complete Revision History.
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PC System Requirements and Software 
Installation

Hardware The minimum hardware requirements are:

   •   1 GHz processor

   •   2 GB RAM

   •   20 GB available hard disk space

   •   USB port

   •   Serial communication port

Operating 
System

The following software must be installed and functional prior to installing

the applications:

   •  Microsoft Windows XP Professional Service Pack 3 or 

   •  Microsoft Windows 7 Professional Service Pack 1

Software 
Installation

The CD-ROM contains software and the User Manual for the Relay Control 
Panel.

Software is installed directly from the CD-ROM to a Windows PC. The CD-
ROM contains the following:

   •  The Relay Control Panel

   •  The relay firmware, and firmware and installation instructions.

   •  User Manual: Relay Control Panel User Manual in PDF format

   •  ERL 61850 IED Configurator

   •  USB Driver

To Install 
Software on the 
Computer

Insert the CD-ROM in the drive. The CD-ROM should open automatically. If 
the CD-ROM does not open automatically, go to Windows Explorer and find 
the CD-ROM (usually on D drive). Open the CD.exe file to launch the CD-
ROM. 

To install the software on the computer, click the desired item on the screen. 
The installation program launches automatically. Installation may take a few 
minutes to start.

To view the Reay User Manual you must have Adobe Acrobat on the comput-
er. If you need a copy, download a copy by clicking on Download Adobe Ac-
robat.
  D02946R02.70 Relay Control Panel User Manual ix



System Requirements
Anti-virus/Anti-spyware Software

If an anti-virus/anti-spyware software on your local system identifies any of 
the ERLPhase applications as a “potential threat”, it will be necessary to con-
figure your anti-virus/anti-software to classify it as “safe” for its proper oper-
ation. Please consult the appropriate anti-virus/anti-spyware software 
documentation to determine the relevant procedure.
x Relay Control Panel User Manual    D02946R02.70



1 Overview

Relay Control 
Panel (RCP)

The RCP is the Windows graphical user interface software tool provided with 
all 4000 series and higher (new generation) ERL relays to communicate, re-
trieve and manage records, event logs, manage settings (identification, protec-
tion, SCADA etc.,), display real time metering values, view, analyze, and 
export records in COMTRADE format. 

The RCP is intended for stand - alone, interactive use with all ERL 
new generation relays. It does not provide automated record or set-
tings collection, a database support or any automated data analysis. 

Access 
Permission

There are four levels of access to relay information using the RCP. The default 
access level which allows the user to work in offline mode and is restricted to 
minimum offline information, such as locally stored recordings and settings.

Similarly, additional levels of password controlled unit access control are 
available for communications and interface with a compatible ERL protection 
relay. The ‘view’, the ‘change’ and the ‘service’ levels of access allow for se-
cured data communication and information transfer through an active Ethernet 
or USB connection, and more advanced system configuration control aspects, 
as defined by role specific  access control. Please refer to “Password Protec-
tion” on page 7-10 for more details on how to set the password control and the 
availability of functionality to interact with the relay using the RCP.

Getting Started The RCP software must be installed on the local Personal Computer (PC) 
along with other necessary drivers in order to successfully communicate with 
the relay. Please refer “Relay Control Panel Installation” on page 2-1 for de-
tailed instructions on the RCP installation procedures. Please also refer the of-
ficial website in the contact information for the latest available versions of the 
RCP software. 
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2 Relay Control Panel Installation

Installation of the Relay Control Panel software may require changes 
to the Windows system configuration for proper operation. Please re-
view the instructions in this chapter to ensure proper setup.

The relay CD-ROM contains the following:

   •  Relay Control Panel Windows software

   •  Firmware update with installation instructions

   •  User Manual in PDF format 

   •  Relay Offliner Settings program

   •  Relay logic diagram in PDF format

2.1 Installing Relay Control Panel
The user must be logged on to the target computer as a user with local admin-
istrator privileges to install Relay Control Panel. Once installed, the user may 
be logged in as a Limited User, as administrator privileges are not generally re-
quired for operation of the program. 

Overview Instructions for installing Relay Control Panel and configuring Windows for 
its use are covered in the following sections. Separate instructions for each ver-
sion of Windows Operating System are provided for the steps below. Use the 
one that is appropriate for the computer. 

The procedure has the following parts: 

1.  Install Relay Control Panel. 

2.  Install Offliner Settings program

3.  Install the Null Modem driver. 

4.  Create Windows Dial-Up Network definitions for modem and direct serial 
connections.

When these steps are complete, go to “First Time Start-Up” on 
page 2-5 for details on launching Relay Control Panel.
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2 Relay Control Panel Installation
2.2 Installation on Windows XP or Windows 7

The user will need to have installed previously the ERLPhase’s USB 
driver from the CD that was shipped with the relay (IED). See relay 
User Manual for instructions.

Step 1: Install RCP 
Software from CD-
ROM

1.  Install RCP Software from CD-ROM.

2.  The CD-ROM should start automatically. If it doesn’t, go to Windows Ex-
plorer and run the ERLPhase.exe file at the root of the CD-ROM directory.

3.  To install Relay Control Panel software on the computer, select the Relay 
Control Panel vx.x Rev x ( x refers to the version number). The installation 
program starts automatically, but may take a few minutes to begin.

4.  During installation a prompt appears asking whether the relay is 50 Hz or 
60 Hz units. For proper operation it is important to select the correct one. If 
the user needs to change this in the future, re-install Relay Control Panel.

5.  When the installation is complete, a Relay Control Panel icon is placed on 
the desktop. Use the icon to launch Relay Control Panel. 

If the user prefers, he can start Control Panel through Windows Start menu 
(Start>Programs>ERLPhase/Relay Control Panel). 

Step 2: Installing 
Null Modem Driver 
Software 

A virtual software modem called a Null Modem must be set up for direct se- 
rial cable communication between this computer and a relay. A Null Modem 
driver is provided with the relay installation CD-ROM.

This section provides step by step instructions on how to install the Null Mo-
dem driver. If you are going to communicate with a 4000 series product please 
ensure that you connect your computer to the front USB port of a powered up 
4000 series unit prior to following these steps.

1.  Start Windows Control Panel by going to Start>Control Panel.

2.  Double-click the Phone and Modem Options icon.

3.  Select the Modems tab. Select Add to open the Add Hardware Wizard.

4.  Select Don't detect my modem; I will select it from a list, then select the Next 
button
2-2 Relay Control Panel User Manual    D02946R02.70



2 Relay Control Panel Installation
Step 1 - Start>Settings>Control Panel.
Step 2 - Double-click Modems icon.

Step 3 - Add

Step 4 - Select Don't detect my modem; 
I will select it from a list. 
Select Next.

Figure 2.1:  Null Modem Driver Installation

5.  Select the Have Disk button, select Browse. To find the file go to C:\Pro-
gram Files\ERLPhase\Relay Control Panel\Null_Mdm.Inf.  Note that di-
rectory Program Files(x86) is used for Windows 7 64-bit operating systems 
instead of Program Files. Select OK. This is the default location for Relay 
Control Panel. If the user selected a different location to install Relay Con-
trol Panel, he will find the Null Modem driver (Null_Mdm.Inf) in that di-
rectory.

Figure 2.2:  Browse for Null_Mdm.Inf
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2 Relay Control Panel Installation
6.  Select the Generic Null Modem driver and select Next. If the user is given 
more than one option, select the one that has the most recent date associated 
with it. 

7.  Select the serial port you wish to use. This is the serial port to be used for a 
direct cable connection to a relay. Typically COM1 or COM2 are available 
on a PC for this purpose. Select Next. 

Figure 2.3:  Select Serial Port

In Windows XP,the user may get a message stating that the Null Modem 
“has not passed Windows Logo testing” and asking “Do you want to con-
tinue the installation?” Select Continue Anyway to continue. 

8.  Select Finish and close the Phone and Modem Options and Control Panel 
dialog boxes.
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2 Relay Control Panel Installation
2.3 First Time Start-Up

Starting Relay 
Control Panel

To start Relay Control Panel, double-click the Relay Control Panel icon placed 
on the desktop by the installation process or select Start>All Programs>ERL-
Phase>Relay Control Panel.

Data Location Relay Control Panel uses a data location on the computer to store records and 
settings from the relays. By default it is My Documents\ERLPhase\Relay Con-
trol Panel or Documents\ERLPhase\Relay Control Panel.

When you change the data location, previously configured IEDs will 
not be affected. Only newly created IEDs will use the new data loca-
tion. To edit the data location of existing IEDs use the Main Menu Edit 
button.

Figure 2.4:  Data Location
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3. Communicating with ERLPhase 
Relays

3.1 Communicating with the Relay (IED)
Connect to the relay to access its interface and Supervisory Control and Data 
Acquisition (SCADA) services through: 

   •  Front USB 2.0 interface (user interface)

   •  1 front and 2 rear Ethernet network links (user interface and SCADA)

   •  Direct serial link (user interface and SCADA)

   •  External or internal modem link (user interface only)

3.2 Setup Type of Communications for IED
Using the Edit button on the Relay Control Panel – Main Menu screen you are 
able to setup the type of communications used to communicate to the IED (re-
lay).

For types of communications use in Relay Control Panel see for details see Fig-
ure 3.1: Screen to setup Communication with IED on page 1-2.

   •  Network Link, use for communicating with the relay (IED) via Relay Con-
trol Panel using Ethernet or LAN communications.

   •  Modem Link, use for communicating with the relay (IED) via Relay Con-
trol Panel using an internal modem or external modem with a phone (land 
line). You can select what modem you want to use by the Modem drop 
down menu and selecting the correct Modem that you want to use for land 
line for remote communications

   •   Direct Serial Link, use for communicating with the relay (IED) front USB 
port via Relay Control Panel using the computer's USB port (ERLPhase 
4000 Series Device (COM number). 

The user will need to have installed previously the ERLPhase’s USB 
driver from the CD that was shipped with the relay (IED).
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3. Communicating with ERLPhase Relays
Figure 3.1: Screen to setup Communication with IED

Figure 3.2: Screen to setup Communication with Multibusbar System
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3. Communicating with ERLPhase Relays
Network Link Modify the Default Gateway and Network Mask if necessary. These settings 
are internal to the IED and may require configuration modification to the IED 
to ensure proper operation. The instructions below reference required changes 
to an ERL relay configuration for successful network communications.

   •  The Default Gateway may need to be changed if the relay and the control 
panel (or RecordBase) are on different but connected networks. The de-
fault setting is No Default Gateway.

   •  The Network Mask may need to be changed if the relay and control panel 
are on different subnets. The default setting is 255.255.255.0.

   •  To modify the Default Gateway or Network Mask use the Maintenance 
Menu command 1- Modify IP address.

   •  If unsure of these setting contact the network administrator.

Relay Control 
Panel Setup

1.  Ensure that the computer running Relay Control Panel has access to the 
Ethernet network to which the relay has been connected.

2.  Start Relay Control Panel.

3.  Choose the target relay from the Select IED list in Relay Control Panel’s 
Main Menu. If there is not already an entry for this relay, create one using 
the Add New button.

4.  Select Network Link, select Port 119 or 120 making sure that the correct IP 
address for the IED in the Port’s IP address field. If required, select Uses 
SOCKS5 Proxy and has the Server IP address and Port Number. Please con-
tact your network administrator for the SOCKS5 Proxy IP address and Port 
Number. You can now Connect via Relay Control Panel’s Main Menu.

You must have view or change access level permission to establish connection 
to the relay.

Modem Link External Modem

1.  Connect a PC-compatible external serial modem to Port 123 on the rear of 
the relay.

2.  Configure the relay’s Port 123 to work with the modem.

Port 123 settings are accessed through the relay’s standard user interface.

a. Establish a USB connection between the computer and Port 123 on the 
relay, run Relay Control Panel software, login with change access level and 
initiate a connection to the unit.

b. When successfully connected, select Utilities in the Main Menu list, and 
go to the Communication tab to access the Port 123’s settings.

c. Set the Baud Rate. This will be the rate at which the relay will communi-
cate with the external modem. It does not control the rate at which the mo-
dems communicate with each other. Unlike a direct serial link, there is no 
need for this baud rate to match that of the remote computer. A rate faster 
than the modem’s top speed is recommended to take full advantage of the 
modem’s compression capabilities.

d. Select External Modem
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3. Communicating with ERLPhase Relays
e. The Modem Initialization String lets you set any special command codes 
required by the modem. The factory default for this field is M0 for external 
modems. These default values are all that are required for most modems.

f. Save the changes, close the Utilities tab and disconnect.

From Main Menu select Utilities,

then the Communications tab.

Set Baud rate.

Enable Modem.

Figure 3.3: Communications Setup Utility

Internal Modem

Access the relay’s user interface through a telephone link between the relay 
and the computer using an optional internal modem (Port 118 if installed). In-
ternal modem configuration is done the same way as for external modem. Mo-
dem initialization string is M0 for internal modem If an internal modem was 
installed at the factory, it will already be appropriately configured.

Relay Control Panel Setup

1.  Select Modem Link. Next select the Modem that is to be use to communicate 
with the remote IED (relay). The modem is selected by the drop down Mo-
dem menu. If the modem that is required is not in the drop down menu, then 
select the button Add New Modem/Serial Link and add a modem to Relay 
Control Panel Edit Relay menu.

2.  Once the correct Modem is selected then add the phone number (in some 
cases additional dialing codes) of the remote IED (relay). You can now 
Connect via Relay Control Panel’s Main Menu.
3.-4 Relay Control Panel User Manual    D02946R02.70



3. Communicating with ERLPhase Relays
Direct Serial 
Link

Your PC must be appropriately configured for USB communication

Laptop PC

Port 150 - USB
Port 150 - USBo t 50 US

Laptop PC

Figure 3.4: Direct Serial Link

Relay Control Panel Setup

1.  Choose the target relay from the Select IED list in Relay Control Panel’s 
Main Menu.

2.  If there is not already an entry for this relay, create one using the Add New 
button.

3.  The method of communication with the relay is specified as part of its IED 
definition. Use the Edit button to view or change this information. Ensure 
the Direct Serial Link option is selected.

4.  Select Direct Serial Link. Next select the COM port that is to be used to 
communicate with the remote IED (relay). The COM port is selected by the 
drop down Serial Link menu. If the COM port that is required is not in the 
drop down menu, then select the button Add New Modem/Serial Link and 
add a new serial COM port to Relay Control Panel Edit Relay menu.

5.  Once the correct Serial Link is selected then use the Baud Rate drop down 
menu and choose the correct baud to communicate to the remote IED (re-
lay). The default Baud Rate is 115200. You can now Connect via Relay 
Control Panel’s Main Menu.

You must have view or change or service access level permission to estab-
lish connection to the relay.
  D02946R02.70 Relay Control Panel User Manual 3.-5





4 Access Level Permissions

Access 
Permission

There are four levels of access to relay information using the Relay Control 
Panel. The default access level, which allows the user to work in offline mode, 
and the view, the change, and the service access levels, which require user con-
nection to the IED. The Relay Control Panel does not support maintenance and 
update level access which is only accessible through a Hyper Terminal session. 
For additional details on these access modes, please refer to the product User 
Manual.

Default Level The Default level of access allows the user to work offline of any device to per-
form offline configurations and view any locally stored recordings and settings 
information. No connection or password is required for this level of access. At 
this access level, the user will not have access to any information stored on any 
IED and will be unable to view live data or manipulate, configure and generally 
alter any IED using the Relay Control Panel application.

View Level The View access level requires a valid password. With this permission the user 
is allowed to have read-only access to the information on the relay. The follow-
ing table summarizes the available functionality.

Table 4.1:  Available Menu - read only access

Records Events Metering Utilites Configuration

On IED Local
Present 
Setting

Saved 
Setting

Graph Graph Print All metering functions 
depending on the relay type

Unit Identification Get From IED Edit

Get From IED Save As Copy Communication Refresh Copy

Refresh Export Refresh Time Delete

Delete External Input Rename

Rename Import

Refresh Save As

Copy 
from IED

Refresh
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4 Access Level Permissions
Change Level The Change access level requires a valid password. With this permission the 
user is allowed to modify or change the information on the relay. This permis-
sion should be granted only to authorized and qualified personal. The follow-
ing table summarizes the available functionality.

Table 4.2:  Available Menu - modify access

Records Events Metering Utilities Configuration

On IED Local
Present 
Setting

Saved 
Setting

Graph Graph Print All metering functions 
depending on the relay type

Unit Identification Get From IED Edit

Get From IED Save As Copy Communication Edit Load from 
IED

Get and Delete 
from IED

Export Erase Time Refresh Copy

Delete Delete Refresh External Input Delete

Refresh Rename Virtual Input Rename

Trigger Fault Refresh Import

Trigger Event Save As

All other available trigger 
depending on relay type

Copy 
from other 
IED

New

Refresh
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4 Access Level Permissions
Service Level The Service access level requires a valid password. With this permission the 
user is allowed to have full access to all the information on the relay. This is 
the highest level access and should be restricted to authorized and qualified 
personal. The 4000 series IEDs typically require Service Port access to permit 
Service level access. The following table summarizes the available functional-
ity.

Table 4.3:  Available Menu - full access to all functions

Records Events Metering Utilities Configuration

On IED Local
Present 
Setting

Saved 
Setting

Graph Graph Print All metering functions 
depending on the relay type

Unit Identification Get From IED Edit

Get From IED Save As Copy Communication Edit Load to 
IED

Get and Delete 
from IED

Export Erase Time Refresh Copy

Delete Delete Refresh External Input Delete

Refresh Rename Calibration Rename

Trigger Fault Refresh Virtual Input Import

Trigger Event Trigger Output Save As

All other available trigger 
depending on relay type Password

Copy 
from other 
IED

New

Refresh

Maintenance 
Level

The maintenance level can be accessed through HyperTerminal Session. 

Update Level The update level can be accessed through HyperTerminal Session.. 
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5 Working with Relay Control Panel

5.1 Relay Workspace
Relay Control Panel supports interaction with different ERL new generation 
relays one at a time. Each relay has its own workspace within the Relay Control 
Panel that stores its records, settings, and communication parameters files.

A separate workspace should be created for each relay on your sys-
tem to store its configuration files and records.

To work with a particular relay, select it from the Select Relay box on the Main 
Menu tab. If you are already connected to an IED you will not be able to select 
a different IED until you disconnect.

Main Menu

Current IED

Select IED - 
Demo Unit

Connect - connect
to a device

Edit - change device
information.

Delete - delete
device from list.

Add New - add new 
device to list

Connection Status - 
Connected or
Not Connected

Figure 5.1: Selecting a Relay Workspace
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5 Working with Relay Control Panel
Current IED Selecting a relay sets Relay Control Panel’s focus to that relay’s workspace, 
known as the Current IED. The records and setting files belong to the selected 
relay.

If you initiate a connection using Relay Control Panel, it connects to the cur- 
rent IED using the communication parameters specified for this IED.

The name of the Current IED is always displayed in the Status Bar at 
the bottom of the Relay Control Panel window (for details see “Se-
lecting a Relay Workspace” on page 5-1.

Relay Control Panel assumes that the relay it is communicating with is the one 
identified as the Current IED. Forcing a connection with a different relay (i.e. 
moving the serial cable without telling Control Panel to disconnect), can cause 
the records and configuration files of that relay to be mixed with those of the 
Current IED.

Relay and System workspaces are added, modified or deleted from the Relay 
Control Panel Main Menu using controls in the Select Relay dialog box shown 
in Figure 5.1: Selecting a Relay Workspace on page 1. Connection access to 
previously defined IEDs or systems using the Connect button is also available 
from the Relay Control Panel Main Menu.

The Edit button displays the selected relay or system definition screen allowing 
changes to be made to the definition. Previously defined settings of the system 
definition are available for review and edit as required.

The Add New button is used to create a new relay or system definition begin-
ning from a blank template, allowing the manual entry of all required informa-
tion or direct extraction from an IED using the device IP address and the Get 
Information From Relay feature.

The Delete button removes the profile from your local system and deletes all 
associated local content.
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5 Working with Relay Control Panel
5.2 B-PRO Multibusbar Workspace Definition
Relay Control Panel supports the control and information aspects of the ERL  
MutiBusBar Protection System, comprised of up to four independent B-PRO 
4000 series relay units, and supporting the use of up to two ERL Digital I/O 
Expansion Modules for increased External Input capacity and System Synch 
clock generation. Similar to a single IED relay, the system has its own work-
space within the Relay Control Panel that stores its records, settings, and com-
munication parameters files.

System level configuration requires the definition of the individual IED IP ad-
dresses within the system, along with the appropriate IED quantity selection as 
indicated within the Edit relay screen. Each IED must be connected to an ap-
propriate Ethernet network in order for RCP to properly operate, manage and 
monitor the system.

To work with a particular system of ERL relays and devices, select the system 
from the Select Relay box on the Main Menu tab. If you are already connected 
to an IED you will not be able to select a different IED until you disconnect.

Figure 5.2: Selecting a Mutibusbar System Workspace
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5 Working with Relay Control Panel
5.3 Adding/Editing a Relay Workspace Definition
Relay and System workspaces are added, modified or deleted from the Relay 
Control Panel Main Menu using controls in the Select Relay dialog box. The 
Add New and Edit buttons access a similar configuration screen allowing the 
user to review and edit a previous workspace definition, or alternately to create 
a new workspace beginning from a blank template. The appearance of the con-
figuration screen will alter based on the selected device or system type to ac-
commodate all the necessary information required for full workspace 
definition. Figure 5.3: Add New Relay on page 4 and Figure 5.4: Add New 
Multibusbar System on page 5  show the two primary screen configurations re-
lated to the Add New and Edit features.

Figure 5.3: Add New Relay
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Figure 5.4: Add New Multibusbar System

Table 5.1:  IED Workspace Settings

IED Definition

Relay Name The Relay Name is the name you assign to this relay's work-
space. It appears in the IED selection and the Current IED 
display at the bottom of the Relay Control Panel window.
We recommend that you use the same name for this work-
space as the Unit Name given to the relay (Unit Identification 
on page 7-2).

Group Name Multibusbar related setting to uniquely identify the system 
workspace.

Comments User-defined, for your reference only.

Location User-defined, for your reference only.

Serial Number Enter the IED Serial Number to match the serial number of 
the actual relay.

Get Information from IED Connects to the relay and retrieves its configured name, loca-
tion and serial number. The corresponding fields in the IED 
Definitions are overwritten.

Model Relay type such as L-PRO, T-PRO, B-PRO, F-PRO etc.

Configuration Additional detail related to the IED factory configuration and I/
O configuration.
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Communication

Direct Serial Link Connect to this relay through a serial cable.

Modem Link Connect to this relay via a telephone link.

Network Link Connect to this relay via a TCP/IP network. When connecting 
via TCP, the user can put an IP address into either port 119 or 
port 120 box. Get IED Information will use the selected IP 
and auto correct the information.

IP Address IP addresses of the relay or system IED’s. The relay's default 
factory IP addresses are 192.168.100.80 and 
192.168.101.80. It is changed through the relay's Mainte-
nance Menu.

Number of MBB Units Number of discrete B-PRO Multibusbar relays included in the 
defined Multibusbar System: Min. 1 unit, Max. 4 units. IP 
addresses for each unit are required.

Number of I/O Units Number of discrete ERL Digital I/O Modules included in the 
defined Multibusbar System: Min. 0 units, Max. 2 units. P 
addresses for each unit are required.

Placement Folder The Default Folder directory applied to new IED definitions 
can be modified with the File>Data Locations command from 
the Main Menu.

Recordings Folder The directory where the IED's retrieved records are stored.

Configs Folder The directory where the IED's configuration files are saved.

Share configuration files and records with other Relay Control Panel 
users by using common folders.

Table 5.1:  IED Workspace Settings



5 Working with Relay Control Panel
5.4 Online and Offline Operation
Relay Control Panel can be used with or without a connection to the selected 
relay. Both offline and online modes work within the selected Current IED 
workspace.

Offline In Offline mode, you can manage and display a relay’s local (previously up- 
loaded) records and create and edit configuration files without being connected 
to the unit.

Online In Online mode you are connected to the relay and have access to both local 
and remote data and functions:

   •  Records (both local and on the relay)

   •  Event log

   •  Metering (real time readings of input and calculated channels)

   •  Channel and trigger configurations (the one presently active in the relay 
and any saved ones you may have created)

   •  Setup utilities and record configuration screens

   •  Record graphics display

Connection 
Status

The Status Bar at the bottom right side of the Relay Control Panel window 
shows if you are presently online or offline, and also shows View Only if in 
view only mode.
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5.5 Navigating in Relay Control Panel
Relay Control Panel uses a split screen format. The left pane is used for nav- 
igation or selection. The right pane is the working area for each of the pro- 
gram's main sections. To bring up the Control Tabs, shown below, you must 
select the appropriate item on the Navigation Tree by double-clicking.

Navigation Tree Working Area

Re-Size Bar

Control Tabs Status Bar

Select Item

Figure 5.5: Relay Control Panel Display Sections Navigation Tree

The left pane provides a means of moving between Relay Control Panel func-
tions or selecting items within a function (e.g. channels from a record). Relay 
Control Panel functions - Records, Fault, Events, Metering, Utilities and Con-
figuration are activated by a double-click.

To optimize the screen space between the tree and the working area to create a 
larger working area some screens have a Hide Tree button to maxi

mize the working area.

Working Area The Working Area on the right pane of the display represents the main working 
area of each section of the Relay Control Panel.

Control Tabs The Control Tabs are a row of selection tabs near the bottom of the screen. 
Each time you start a function, a corresponding tab is created.

Select the control tabs to navigate from one screen to another or the Main Menu 
item. Use the Close button to close the screen.

Status Bar The Status Bar at the bottom of the Relay Control Panel displays the name of 
the selected relay workspace and the status of the connections and view only 
mode.
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6 Metering Display

The relay has a full set of real-time metering displays that provide present read-
ings from the analog input channels and all other metering items such as pro-
tection, external input, ProLogic, group logic, virtual input and other items 
depending on relay type.

The Metering display is accessed through the Metering item in the Main Menu 
tab's function list.

Figure 6.1: Metering Display

Standard Metering Screens

 The metering display provides tabs at the bottom to select among multiple dis- 
play screens depending on the relay type. Please refer the respective relay in  
“Control Tab Options” in Appendix A. for relay specific metering control tabs.

Primary/Secondary

Metered values can be shown as either system primary or secondary quantities.

Display Zoom

The magnification of metering screens can be adjusted using the Zoom Level 
(%) control. This allows the display to be enlarged for easy viewing while com- 
missioning or testing.

Freeze

The freeze button provides a way to temporarily stop the update of the display. 
It can be used to ensure a synchronized set of readings for documentation pur- 
poses. The metering display can be exported to another program using Win- 
dows built-in Alt PrintScreen key and standard paste functions.
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6 Metering Display
Phase angle readings displayed in meter groups are based on the 
reference voltage Phase Angle Reference Channel as referenced in 
the protection settings manual for respective relay type.
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7 Relay Setup Utilities

The relay has global setup parameters that establish its identity and define its 
operation. Setup parameters define:

   •  Unit identification

   •  Communication port parameters

   •  Time display and settings

   •  External Input

   •  Virtual Inputs

   •  Analog input calibration

   •  Passwords

   •  Toggle Outputs

   •  Other relay specific control tabs

Please refer to “Control Tab Options” in Appendix A. for each relay specific 
control tabs.

The Relay Control Panel application is designed to interface with and config-
ure a wide variety of IED’s. This section describes the control tabs for most 
IED’s. Not all control tabs are applicable to all units. Device specific informa-
tion will be available in the User Manual provided with the IED, and accessible 
within the associated Offliner application.

Figure 7.1: Relay Setup Utilities
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7 Relay Setup Utilities
The setup parameters are accessed through the Utilities tab on relay 
Control Panel. The user must be communicating with the IED for the 
Utilities tab to be available.

For details on connecting to the relay using Relay Control Panel soft-
ware see “Communicating with the Relay (IED)” on page 3.-1.

7.1 Unit Identification
The Unit Identification tab identifies a particular relay and its records. Double-
click Utilities to bring up the tabs; select Unit Identification. 

Figure 7.2: Unit Identification

Table 7.1:  Unit Identification Settings

Identification

Device Serial 
Number

Read-only field, displays the serial number of the relay unit currently 
connected.

Unit ID User-entered field that identifies the unit. It is part of the name given to 
records produced by the unit to identify their origin. 
By convention, this name should be the same as the "IED Name" 
assigned to the relay and relay’s workspace. The name must not con-
tain the following: “,” “/” “\” “:” or any other character not valid for a Win-
dows file name. 
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7 Relay Setup Utilities
Software Version Read-only field that displays the firmware version of the currently con-
nected relay unit.

Required Set-
tings Version

Describes the version of the settings file required by the connected 
relay. Control Panel is capable of creating older versions of settings files 
for use with relays whose firmware has not been updated (see “Manag-
ing Configuration Files” on page 8-1).

Communication 
Version

Read-only field that displays the version of the communications protocol 
used by the currently connected relay unit.

Nominal System 
Frequency

Read-only field that displays the assumed power system frequency of 
the relay, This is a factory setting.

Station

Station Name User-defined, for reference only.

Station Number User-defined, for reference only.

Location User-defined, for reference only.

Table 7.1:  Unit Identification Settings
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7.2 Communication Port Settings
The Communication settings tab controls the modes and baud rates of the re-
lay’s communication ports. This feature may not be available or required for 
all IED’s or systems.

Figure 7.3: Relay Setup Utilities - Communication Ports 

Table 7.2:  Communication Settings

Service Port

The Service Port is Port 150 on the front of the relay. It can be used for connection with Relay 
Control Panel or a terminal program (to access the Maintenance Menu). 

Baud Rate Sets the baud rate of the port. The default baud rate is 115,200 N81 
baud. 
Note: The baud rate must match that of the port of the computer con-
nected to this port.

For best results, use the maximum baud rate that the communication 
link and equipment can sustain.
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Direct/Modem Port

The Direct/Modem Port refers to either the relay’s rear panel Port 123 or its (optional) Internal 
Modem port, depending on the Port Select setting. 

Port Select Direct Serial: Port 123 is enabled for a direct serial connection with 
Relay Control Panel or a terminal program (to access the Maintenance 
Menu). 

External Modem: Port 123 can be used to connect to an external modem 
through a serial link.

Internal Modem: Enables a modem connection through the relay’s rear 
panel RJ-11 Internal Modem Port. Requires that the relay has the inter-
nal modem option installed. The internal modem can be disabled 
through the Maintenance Menu.

Baud Rate Sets the baud rate of port 123. The default baud rate is 38,400 baud. For 
a direct serial connection on Port 123, the baud rate must match that of 
the port of the computer connected to this port. 
When configured for an internal or external modem, the baud rate speci-
fies the rate at which the relay communicates with the modem. The 
actual communication rate between modems is less than or equal to this 
setting, depending on what the modems can negotiate over the phone 
line. 

For best results, use the maximum baud rate that the communication 
link and equipment can sustain.

Modem Initializa-
tion String

When using an internal or external modem, a modem initialization string 
can be entered containing modem control codes. The factory default for 
this field is "M0". Refer to the modem manual for details.

Datalink Timeout Used only for DNP3 Level 2. This sets the timeout for the DataLink layer 
of the DNP protocol. Although configurable, the timeout should be disa-
bled (set to 0 milliseconds) as per the DNP Users Group “Technical Bul-
letin 9804-002 DNP Confirmation and Retry Guidelines”. The DataLink 
Timeout is automatically disabled when using either DNP3 Level 2 - TCP 
or UDP.

Master IP 
Address

For either DNP3 Level 2 - TCP or UDP, the Master IP Address must be 
set to the IP address of the master device that will be polling the relay. 
This prevents unauthorized master devices from communicating with the 
relay. Note: This setting does not control the IP address of the relay’s 
Ethernet port. That is done through the relay’s Maintenance Menu. Make 
sure the Master IP address is different from the relay’s IP address.

Port For either DNP3 Level 2 - TCP or UDP, the Port is the TCP or UDP port 
that the DNP service may be accessed at and is usually set to 20000.

Table 7.2:  Communication Settings
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7.3 Time Display and Settings
The Time Control tab displays the device’s current time and provides controls 
to select and configure the source time signal for the IED, or manually config-
ure the initial time parameters of the system. 

Figure 7.4: Relay Setup Utilities - Time Control 

Time Sources The 4000 Series ERL relays use time as a fundamental component of protec-
tion, fault logging, data logging and record generation requiring the presence 
of a source time signal or suitable alternate be available to the IED. The device 
supports the use of modulated or unmodulated IRIG-B time signals (external), 
primary/secondary SNTP network based time synchronization (external) and 
manually configurable system time based on a free-running, internal oscillator. 
The internal free-running oscillator is always present on the IED and, in the ab-
sence of any external time source, will become the default mode of time syn-
chronization. Note that not all relays support SNTP.

An IRIG-B time source will have the highest order of precedence and the high-
est available time accuracy. The ongoing presence of a valid IRIG-B time 
source is indicated by an LED on the front panel of the IED and is evident in 
data records.

An SNTP time source has a lower order of precedence from a valid IRIG-B 
source. SNTP operation (primary and secondary) requires network access and 
the selection and configuration of suitable SNTP network sources. The SNTP 
time may be configured for re-synchronization cycles ranging from 15 minutes 
to 36 hours, adjusting the IED system time to an accuracy within +/- 1 second. 
No visual indication is provided on the IED front panel regarding the status of 
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7 Relay Setup Utilities
the SNTP synchronization however this information is available in data re-
cords.

The IED comes equipped with an internal free-running oscillator used to gen-
erate a 1 PPS time signal in the absence of any alternate available time source. 
Use of this oscillator as the primary IED time source requires manual time con-
figuration, with the general accuracy subject to user input parameters, and is 
recommended primarily for stand-alone, unsynchronized applications. The in-
ternal oscillator carries a lifetime accuracy (including temperature effects and 
aging) of +/-25 ppm.

Displayed Time Time is maintained in UTC format on the relay (i.e. without a time zone offset 
or daylight savings time applied). If the clock feeding the IRIG-B time signal 
to the relay is sending local time, the relay converts it to UTC internally.

The time displayed in the Time Control screen above is determined by the ad-
jacent time display settings. The relay will automatically convert from its in-
ternal UTC time as required. The relay Time Zone Setting determines the 
offset between Local time and UTC. DST will automatically add 1 hour to the 
offset if appropriate.

System Sync 
Source

The 4000 series ERL relays support the application of a System Sync time 
source provided from another ERL IED which provides an IRIG style time out-
put derived from the IED source clock. Time quality information within the 
output signal is modified to reflect the derived source.

Event and 
Record 
Timestamps

Event timestamps in the relay’s Event Log are also controlled by the above 
time display settings. They will be displayed as UTC or local times as config-
ured here.

Record timestamps shown in Control Panel’s Records tab are handled a bit dif-
ferently. Record times are converted from UTC using the Windows Time and 
Date settings of the PC running Control Panel. This enables records from mul-
tiple time zones to be normalized to a common time zone and format.

Table 7.3:  Time Settings

IED Time is 
displayed as

UTC Sets the time display and the Event Log timestamps to Universal 
Coordinated Time (UTC). Note that UTC time is not affected by the 
relay Time Zone setting or Daylight Savings Time. 

Local Time Sets the time display and the Event Log timestamps to Local Time. 
Local time is converted to UTC using the relay Time Zone setting.

Local Time with DST Same as Local Time, except Daylight Savings Time (DST) is fac-
tored into the time conversion. Daylight Savings Time is assumed to 
be in effect from 2 AM on the first Sunday in April until 2 AM on the 
last Sunday in October. 
  D02946R02.70 Relay Control Panel User Manual 7-7



7 Relay Setup Utilities
.

Present Time
Display

When connected to a relay, the relay’s present time is shown and 
continually updated. The specified time settings (e.g. Local Time) 
are applied to the displayed time.

Sync/No Sync
Display

Indicates that the relay is synchronized to an IRIG-B time signal 
input.

Incoming IRIG 
Signal Properties

These settings determine how the relay responds to IEEE 1344 
information in the IRIG-B time signal and manually define the format 
of the incoming time if IEEE 1344 data is not available.

Use IEEE 1344 If 
Present

If Use IEEE 1344 if Present is checked and the source clock gener-
ates IEEE 1344 data, the relay: 

• uses the time zone offset from the IEEE 1344 data embedded in 
the IRIG-B time signal

• reads the IEEE 1344 data to determine the mode of the incom-
ing IRIG signal (UTC, Local, Local with DST)

Otherwise, the relay uses the manually entered time zone offset and 
clock source mode settings.

Do not use IEEE 
1344

If Do Not Use IEEE 1344 is selected, the relay will ignore any IEEE 
1344 data in the IRIG-B signal and use the manually entered time 
zone offset and clock source mode settings.

IRIG Source Specifies the mode of the incoming clock signal. Ignored if IEEE 
1344 data is present in the IRIG-B time signal and the Use IEEE 
1344 If Present setting is enabled. 

Manually Set IED 
Time

Allows the relay’s clock to be manually set if an IRIG-B signal is not 
present. If an IRIG-B signal is present, but does not contain IEEE 
1344 data, the year can be set manually. 

Relay Time Zone 
Setting

Provides the offset from local time to UTC in hours. For example, 
Central Time has a +6 hour offset from UTC. 
This setting is ignored if IEEE 1344 data is present in the IRIG-B 
time signal and the Use IEEE 1344 If Present setting is enabled. 
This is expanded with the user being allowed to set DST start and 
end. 

Table 7.3:  Time Settings
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7.4 Analog Input Calibration
The Calibration Utility provides a means of calibrating the relay’s analog input 
channels. It is accessed through the Relay Control Panel’s Utilities tab as An-
alog Input Calibration, but requires service access to the service port.

Figure 7.5: Analog Input Calibration

AC Channel 
Calibration 
Process

To calibrate a channel (Main Menu>Utilities>Analog Input Calibration):

1.  Select the channel or channels from the list. More than one channel of volt-
age or current can be chosen using the Control/Shift + left-click.

It is possible to calibrate multiple channels simultaneously by using 
the mouse to select a set of channels from the list. Multiple channels 
can be selected using standard Windows selection methods. 

All channels in the selected set must have the same type of input.

2.  Enter the voltage or current magnitude that is associated with the channel 
Applied Signal field. The signal magnitude level should be measured with 
a precision calibrated instrument. 

3.  Select the Calibrate Offset and Gain button. If a channel has not yet been 
configured, only Calibrate Offset will be displayed.

4.  Under the Offset and Gain columns the line of the channel being calibrated 
OK or No will be displayed (see “Analog Input Calibration” on page 7-9).

5.  Repeat for all other channels being used.

6.  Use the Save button to load the new calibration to the relay.
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Out of Range An error message is displayed if the applied signal as seen by the relay differs 
from the value entered in the Applied Signal field by more than 10%. This 
helps to prevent erroneous calibration.

7.5 Password Protection
Access to various relay functions can be protected through the use of pass-
words, requires service access on service port. Passwords are now required and 
can contain a-z, A-Z, 0-9, -+=.

Figure 7.6:  Password Protection

There are three user access levels: view, change and service. The factory de-
fault passwords for the three access levels are:

VIEW: view

CHANGE: change

SERVICE: service

Setting 
Passwords

Passwords can be viewed and set through the Passwords tab of Relay Control 
Panel’s Utilities screen. 

The Password tab can only be accessed when connected via direct 
serial link through the relay’s service port (Port 150). This provides 
protection from unauthorized remote access while ensuring that on-
site staff can freely use the relay.
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Testing the 
External Inputs

To test the external inputs, connect to the IED using the service access level 
and select Metering>External. This screen will display the status of the IED 
External Input contacts. Application of a suitable dc signal to an external input 
(polarity sensitive, input level based on configuration) will cause the input sta-
tus to change from a Low to High status. External input status update within 
Relay Control Panel may require up to 0.5 seconds for changes to appear.

Figure 7.7: Testing External Inputs

 Testing the 
Output Relay 
Contacts

To test the external inputs, connect to the IED using the service access level 
and navigate to select Utilities>Toggle Outputs. This feature will allow the 
user to enter a Test Mode allowing the individual output contacts to be manu-
ally toggled to verify operation. To enable this feature, select the check box to 
place the system into Test Mode. In multi-unit systems, IED selection may be 
required to identify the specific contact to be tested. Toggle the output contact 
(s) as desired using the OPEN or CLOSED buttons provided. Verify the correct 
operation through the use of an ohmmeter, contact connection or through the 
Relay Control Panel application by navigating to Metering>External and con-
firming the desired state change. Multiple contacts may be toggled while the 
system is in Test Mode. Upon exiting Test Mode, either by deselecting the 
checkbox or closing the Utilities>Toggle Outputs tab, the contact status will 
revert to their default status.
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Figure 7.8: Testing Output Relay Contacts
7-12 Relay Control Panel User Manual    D02946R02.70



8 Configuring the Relay

Where the Setup Utilities of the previous chapter specify the relay’s global 
characteristics, it is the relay’s Configuration File that defines its individual 
channels and recording triggers. 

The configuration file identifies and adjusts the relay’s input channels, derived 
(calculated) channels, record triggers, metering displays and trend logs. It also 
specifies how the relay handles record storage and excessive trigger condi-
tions. Configuration files are created and managed by Relay Control Panel and 
loaded into the relay’s non-volatile memory through the communications link.

8.1 Managing Configuration Files
Relay Control Panel’s Configuration Manager creates and manages configu-
ration files and handles transfer to and from the relay. To open the Configura-
tion Manager screen, double-click the Configuration line in the left pane of the 
Main Menu screen.

The configurations shown in the Configuration Manager screen are specific to 
the selected Current IED. To work with configurations from another relay, the 
user must first select that unit as the Current IED (from the Main Menu). 

Figure 8.1: Configuration Manager
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8 Configuring the Relay
Editing a 
Relay's Present 
Configuration

Present Settings

Figure 8.2: Present Configuration

The user can also transfer the relay’s present configuration to a saved file in the 
Relay Control Panel using the Get from Relay button. When transferred, the 
configuration appears in the Saved Settings list.

Saved 
Configuration 
Files

Saved Settings

New Configuration

Figure 8.3: Saved Configurations

Saved configuration files are shown under the Saved Settings heading in the 
list. The Relay Control Panel can store many saved configuration files, limited 
only by hard disk and Windows operating system constraints.

Saved configuration files can be created, displayed and modified, copied, re- 
named, deleted or loaded into the relay. Click the desired configuration from 
the Saved Settings list, then select the appropriate action button on the right of 
the screen. Double-clicking on a configuration is equivalent to clicking the 
Edit button.
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It is recommended that you maintain a copy of each relay's current 
configuration as a Saved Setting for a backup. It can be loaded into 
a replacement relay if the unit ever needs to be serviced.

Loading a 
Saved 
Configuration

A configuration file must be compatible with the firmware on the relay 
in order to be loaded. Compatibility is defined by the Settings Ver-
sion, a number which identifies the version of configuration file a giv-
en version of firmware requires. When loading configuration to a 
multi-unit system, all units must be compatible.

Attempting to load an incompatible configuration file to an IED will re-
sult in an error message being generated and halt the configuration 
download.

The following specific error messages are displayed on attempting an upload: 

   •  “Load Failed”: Relay not running

   •  “Load Failed”: Relay memory error

   •  “Load Failed”: Relay unable to load to DSP

   •  “Load Failed”: Invalid serial number

   •  “Load Failed”: Invalid version

   •   “Load Failed”: Invalid configuration file

   •  “Load Failed”: Bad frequency setting

   •   “Load Failed”: Bad CT format

   •   “Load Failed”: Invalid IO model

   •  “Load Failed”: Invalid network card configuration

   •   “Load Failed”: Unknown Reason # (where # is the error number to be pro-
vided to customer support)

To load a configuration file from the Saved Settings list into the Current IED, 
the user must be communicating with the relay. Initiate the load by selecting 
the desired configuration file and clicking the Load to Relay button. The relay 
will immediately load and run the new configuration. Complex configurations 
can take a few minutes to transfer and load, depending in part on communica-
tions rate. The relay will acknowledge the new settings back to Control Panel.

The relay will automatically go through a reset when loaded with a 
configuration that changes its sample rate. This will add an approxi-
mately two minutes to the load time.
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Creating a New 
Configuration

 Use the New button to create a new configuration file. New configuration files 
are compatible with the latest Setting Version by default. The Setting Version 
can be changed if desired to create new configuration files for older relays.

The fixed information in the Device Configuration screen is derived from the 
IED Definition “Adding/Editing a Relay Workspace Definition” on page 5-4.

Using Another 
Relay's 
Configuration 
as a Starting 
Point

 Use the Copy from Other Relay button to create a configuration for the current 
relay based on an existing one from another IED. The configuration can be 
chosen from a list of the saved settings of the other IEDs defined in the Relay 
Control Panel.

Configuration 
Editor

The Configuration Editor provides the means to create, display and modify 
configurations for the relay. To start the editor from the Configuration Manag-
er screen, either double-click on a configuration file or select it and click on the 
Edit button.

Depending on the type of the relay (L-PRO, T-PRO, B-PRO, F-PRO etc.) an 
Offliner Settings program will be launched which will present an independent 
Windows application program. Please refer to the descriptions of the respec-
tive relay type user manual for the detailed descriptions of the various func-
tionality such as Identification, System Parameters, Line Parameters, 
Protection functions, ProLogics, Output Matrix, Setting Groups, Group Log-
ics, SCADA Settings, and other functionality as applicable. 
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9 Record and Log Management

9.1 Records
The record management services are available from the Records tab, accessi- 
ble from the Main Menu.

Figure 9.1: Record Listing

Record Lists The left side of the Records tab shows lists of records for the current IED or- 
ganized by date. Expanding a date entry shows On IED and Local headings. 
Records presently on the relay are shown under the On IED heading. Records 
that have been previously transferred to Relay Control Panel are shown under 
the Local heading. Records on the IED that have not been transferred to Con-
trol Panel are shown in bold-face. If working offline, only local records are 
shown.

Record Filter The list of records displayed is controlled by the Record Filter control. The fil-
ter applies to both On IED and Local record lists. The time taken to access the 
directory can be controlled by selecting an appropriate number of records in 
the Record Filter.

Note that if additional recordings are created through the Trigger Fault, or any 
other buttons (depending on relay type), these new records do not displace the 
earliest fetch/displayed file records in the tree.

Trigger Fault/ 
Trigger Swing/ 
Trigger Event

The relay can be manually triggered to generate different types of records. 
Trigger fault and Trigger event control tabs are available on all relays. The oth-
er control tabs of the Recording screen are specific to relays.
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Please refer to the relay in “Control Tab Options” in Appendix A. for relay spe-
cific specific control tabs

Record timestamps are received from the relay are in UTC and are 
converted to local time using the Time Zone and Daylight Saving set-
tings of the computer running Relay Control Panel.

Record 
Summary

The right side of the Records tab shows summary information on the selected 
record. The summary includes the list of events which occurred during the 
time-span of the record from the relay's event log.

Get Remote 
Summaries/
Fetch Remote 
Events

When both Get Remote Summaries and Remote Event options are checked, 
Control Panel accesses and displays the corresponding recording in- formation 
in the Record Summary and Events sections of the right-hand pane. The user 
may eliminate the delay involved in accessing this information by disabling the 
corresponding check-boxes.

Autopoll/
Autoprint

When Autopoll is checked, Relay Control Panel will periodically (default 60 
seconds) poll the connected Relay for new record files and automatically trans-
fer them to the local computer. Newest records will be transferred first, and 
only one new record will be transferred at each poll. Checking Autoprint will 
cause each transferred (via Autopoll) record file to be automatically printed on 
the default Windows printer using RecordGraph’s default template.

Note that the Autopoll and Autoprint states are not persistent; if Control Panel 
is disconnected from the relay, both Autopoll and Autoprint become un- 
checked.

Note also that RecordGraph is unavailable when Autoprint is enabled.

Graph Records can be viewed with RecordGraph, ERLPhase’s interactive graphing 
software. To launch RecordGraph, select one or more local records and select 
the Graph button or double-click.

Get from IED Selecting a relay file under On IED and then selecting the Get from IED button 
causes a record file on the IED to be transferred from the relay to your local 
computer. More than one file can be transferred at the time using Windows file 
selection function (Control/Shift + left-click). This action will not delete the re-
cord on the IED.

Get from IED 
and Delete

The Get From IED and Delete button erases the records on the relay after they 
have been transferred to Control Panel and verified.

When connected to a cooperative group, Get From IED automatically transfers 
the corresponding record from each group member and combines them into a 
single group record.
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9 Record and Log Management
Save As Selecting a local record and selecting the Save As button copies a record to a 
specified file. The.lpr (for L-PRO) file suffix should be retained and is relay 
dependent.

Export Selecting a local record and selecting the Export button launches the Export 
Utility. Records can be exported in common formats such as COMTRADE for 
use in other software or playback.

Delete The Delete button can be used to delete records on the IED or locally. More 
than one file can be deleted at a time using Windows file selection functions 
(Ctrl/Shift + left-click).

Rename Select Rename to allow a local record file to be renamed. Records on the relay 
cannot be renamed.

Refresh Selecting Refresh updates the Recordings screen. It checks the local directory 
and the remote IED (if connected) for new and stored files, updates Control 
Panel's records database and refreshes the screen.

Recordings 
Stored

Shows the number of records stored on the relay and percentage of recording 
space used.

File>Select 
Remote

This function is available through the On IED menu. If the user is online with 
the relay, this function selects all of the recording files displayed in the record 
list that have not yet been transferred to your local Recordings directory. The 
user may then perform whatever command is appropriate for the selection set, 
such as a Get from IED or a Get and Delete from IED Command.
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9 Record and Log Management
9.2 Event Log
The event log services are available from the Events tab accessible from the 
Main Menu.

Figure 9.2: Event Log Display

The relay maintains a log of time-stamped events. Event messages can be pro-
duced by any of the relay's detectors if configured to do so.

Event messages can also be viewed in the Record Summary display

Circular 
Storage

The Event Log stores up to 250 events with automatic overwrite of the oldest 
event

Event 
Messages

The text of an event message is derived from the configuration of the detector 
that generates it.

The general format for event message is:

Date Time Element Name.Type.Description Detector State where:

   •  Element Name is the user-assigned name of the element associated with 
this channel

   •  ChannelType describes the member of the element or the type of channel 
which the detector is monitoring

   •  Description is user-assigned text available to further identify the detector

   •  Detector is the type of detector

   •  State indicates whether the detector is picking up or dropping out. In the 
case of external inputs this text is user-assigned to accommodate different 
external devices.

Example of an event message from an External Input detector
9-4 Relay Control Panel User Manual    D02946R02.70



9 Record and Log Management
2010 Jul 12 20:44:33.672 Line #1.EI.BRKRI-a open

Example of an event message from a high analog level detector:

2010 Jul 12 20:44:33.650 Line #1.Va.High Mag active

Printing Event 
Log

The user may print or copy to clipboard all the events that are in the Event Log.

Choose from the menu bar to print event logs while connected to the IED.

Controls The event display is a static snapshot of the contents of the event log.

The user can use the buttons at the bottom to access these functions. In addi-
tion, print commands are available under the File menu, a copy com- mand is 
available under the Edit menu, and a refresh command is available un- der the 
View menu.

Table 9.4:  Event Commands

Refresh Updates Event List by getting a new list from remote IED and 
updates the Event List screen.

Erase Removes all events from remote IED in change and service 
only..

Print (bottom button only) Prints all the events (up to 250 events) to 
a local printer.
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9 Record and Log Management
9.3 Fault Log
The fault log services are available from the Main Menu tab, accessible from 
the Main Menu.

Figure 9.3: Fault Log Display

The relay maintains a log of time-stamped fault information. Fault messages 
will be triggered only for trip condition and will not log alarm conditions.

Circular 
Storage

The Fault Log stores up to 100 events with automatic overwrite of the oldest 
event. The quantity of available individual faults on the IED is indicated in the 
lower left hand side of the faults display.

Event 
Messages

The text of an event message is derived from the IED time and the nature of 
the protection fault encountered, which will always be specific to the nature 
and configuration of the IED. Fault Log data is uniquely identified by the time-
stamp and the associated protection details (faulted phase, fault quantities, etc. 
as applicable).

Controls The faults display is a static snapshot of the contents of the event log.

The user can use the buttons at the bottom to access these functions. In addi-
tion, print commands are available under the File menu, a copy command is 
available under the Edit menu, and a refresh command is available under the 
View menu.

Table 9.5:  Fault Commands

Refresh Update faults by getting a new list from remote IED and 
updates the Faults screen.
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9 Record and Log Management
Clear Faults Removes all faults from remote IED in change and service 
only.

> , >>, <, << Scroll through available faults, single fault at a time using the 
single arrows, or scroll to start/end using double arrows.

Close Exit Fault Log screen and close tab,

Caution: Selecting the Clear Faults button within Relay Control Panel 
will permanently removed and delete all Fault Logs from the IED.

Table 9.5:  Fault Commands
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10 Graphing Records

10.1 Getting Started
RecordGraph is a tool used to display and analyze records from ERLPhase re-
lays. Use it to graphically view the data recorded during fault, swing and trend 
modes. RecordGraph is a separate program with Relay Control Panel.

Launch 
RecordGraph 
from RCP

Method 1: Records

1.  Open Relay Control Panel by double-clicking on the  icon on the desktop. 
If the application is not installed, install the application and then proceed.

2.  Double-click on the Records item in the tree list or select Records and use 
the Enter key. 

3.  Using the Records tab, select a local record from the tree list.

4.  Click the Graph button.

Figure 10.1:  Launching RecordGraph from Relay Control Panel

When the Graph button is clicked from the Relay Control Panel, RecordGraph 
is launched with the selected record.
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10 Graphing Records
Method 2: Auto Print

If the Auto Print option is checked (enabled) in the Records list view, then Re-
cordGraph will be automatically launched and prints the channels directly on 
to the Default printer. The layout and channel information is predefined in the 
<Default> or User-defined template.

Enabling the Auto Print option can result in a significant quantity of 
printed pages depending on the level of system activity.

See the RecordBase view manual for complete details of the various 
functionality within the RecordGraph tool.
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